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Abstract. The GENESIS project, partially funded by the European Commission (DG INFSO in the FP7
framework) provides an efficient Web-based software solution that can be used by all kind of actors involved
in environment management and health services in Europe. The solution takes aboard various leading-edge
technologies like multi-linguality and ontologies, sensor networks, near-real-time data fusion, dynamic work
flows, portlet-based customizable portal and many more. A set of multi-thematic pilots is developed based on
the GENESIS solution as a proof of concept.
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1 INTRODUCTION

The current situation of Environment management and Health actors is characterized by numerous barriers to
efficient cooperation and sharing of resources, mainly caused by:

e Scattered services, data and catalogues,

e  The lack of standardization of legacy system.
The GENESIS project has the objective of defining and developing an efficient solution based on advanced ICT
to constitute collaborative information networks, integrating existing systems.

Fig. 1. GENESIS thematic-neutral collaborative framework



The GENESIS system is willing to offer an efficient solution to:

e Build integrated Environment & Health information systems easily accessible through Web interfaces,
with collaboration of remote information systems or actors (at regional, national and European levels).

e  Support environmental monitoring processes, and assessment of environment impact on health.

e Help all actors to get enhanced access to the geo-spatial information or services available all over
Europe, independently from their location.

e Help data / services providers to upgrade their existing information systems, to promote standards and
interoperability, in relation with INSPIRE and environment policy directives.

e Help thematic communities to build for their own purposes new applications or services related to
Environment & Health by chaining various services (data access, viewing, processing, ...)

2 GENESIS SOLUTION

The GENESIS software solution is based on an “INSPIRE Compliant” Service Oriented Architecture (SOA)
composed of a set of secured, standardised Web Services and customisable Web Service Clients that can be
easily deployed in a Web Portal.

The Web Services that are made available cover the full chain from discovery of data and services to the
exploitation of processing results. Interested parties can select single Open Source services or make use of the
GENESIS integrated solution. Within the GENESIS SOA, these services are deployed using the SOAP protocol
bindings to enable service orchestration by a central workflow controller and a common authentication and
authorisation mechanism. Most Web Service interfaces that are employed in this project are compliant with the
most recent OGC Specifications that are either recently adopted or are under definition with technical work
related to the standard definition and maturation performed within the GENESIS project (e.g. Sensor Catalogue
Service).
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Fig. 2. GENESIS architecture based on the INSPIRE guidelines

The GENESIS architecture illustrated in the previous picture will be described in more details in the
following sub sections. The GENESIS system also includes the tools as for example an interconnection legacy
toolbox to easily integrate Thematic data and processing so that “Thematic” Information System can be built as
an instantiation of (a subset of) the services and client building blocks that GENESIS delivers combining generic
services with specific “thematic” processing components as shown on the following figure.
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Fig. 3. GENESIS thematic-neutral collaborative framework with its “toolbox”, the legacy interconnection solution to
painlessly plug-in existing application.

An extra effort is added to on information dissemination to promote GENESIS and its use thanks to
demonstration, tutorials, videos and on-line help

2.1 DISCOVERY SERVICES

The first set of services publish OGC Catalogue Service for the Web (CSW) Interfaces and allow the discovery
of Geographic Web Services, EO data set (series), GIS data set (series) and Sensors. These catalogues of meta-
information allow both the management and discovery of metadata of the various resource types. Most of these
metadata sets are managed using the ebRIM information model in which different extension packages can be
expressed for different types of metadata, but the discovery mechanism is common for all metadata types.

Additionally, because all of the metadata for the different resource types are expressed in ebRIM, new
associations between different resource types (e.g. EO Product collections and Sensors) can be added to link
previously unassociated metadata. Additional important associations or classifications can also be added to
enhance the semantics of the metadata to improve the discovery significantly e.g. retrieving of EO collection
information based on sensor characteristics and navigate from EO collection information to the associated sensor
description. The catalogue service components come with a graphical user interface to manage the catalogue
configuration, allow metadata discovery and editing and bulk metadata harvesting.

An ebXML Registry Repository implemetation with Earth Observation extensions.
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Fig. 4. Buddata catalogue administration tool easing the management of meta-data harvesting, manual update etc...

Two different implementations are being validated and integrated with the GENESIS Portal: one is based on
the ERDAS COTS and the second one is based on the Buddata eb XML Registry open source catalogue services.
Both catalogue products provide an implementation of the latest CIM, EOP and Sensor Discovery OGC
specifications. The Buddata ebXML Registry core components ahev also been integrated in the legacy
Interconnection Toolbox. This tools provides an advanced catalogue management creation interface and
implements an INSPIRE compliant Fagade allowing the access to the metadata stored in EbRim format via an
1SO Application Profile client.

2.2 DATA ACCESS SERVICES

A second set of services allows accessing vector, raster or sensor measurement data in accordance with the
latest versions of the OGC Web Service interfaces (OGC WFS, WCS, SOS). Not only data access services but
also the portrayal services that render these data sets into map images (and exposed using the OGC Web Map
Service Interface Specification) are covered within this task.
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Fig. 5. Time Series of coverage maps animated by GeoData Visualisation Portlet.

These data access services are all implemented using SOAP bindings to allow orchestration and the use of the
Web Service Security Specifications. The INSPIRE SOAP Primer and proposition for WSDL are used as the
basis for the SOAP implementation which will be released as Open Source Software.

To handle Non Geodata access, a web-based tool is developed to allow the design of complex data models by
non-expert users. The tool allows designing the data model and to instantiate a Web Feature Service and a
corresponding datastore to publish this type of data. Such a web service instance implements the WFS-T
specification with SOAP bindings. The modern web-based GUI allows drag and drop of model components and
sharing of data models with peers.

2.3 DATA PROCESSING SERVICES

A third set of services deals with data processing including data fusion, geo data processing and decision support
services. The data fusion services covers several aspects such as merging of several data formats, execution of
thematic algorithms expressed with OpenMath language using a computation engine, processing of alerts. In
addition a set of robust geographic processing web services have been developed that cover typical GIS and EO
processing requirements. All these services are using the OGC WPS interface with SOAP binding and some
improvements to support long running processes and asynchronous messaging using WS-Addressing. Tools have
been developed to support the deployment of such services and to automatically generate the configuration files
for instantiating the GENESIS WPS client interfaces inside the GENESIS Portal.



» BBox
» Clip - =
» Polygon
» MapAlgebra »  Format |
> Grid » Reprojection
» Raster » Transform
» Coordinates - » OrthoRectification
» CoRegistration
+ OverBands
» Statistics
» PerBand
| Geolnformation |
. Processing » Format
» Coordinates
+» Vector » Transform - :
» Clip » Polygon
» Generalize
» VectorToRaster » Interpolate » InverseDistanceWeighting
» Polylines
: » Intersect —_
->RasterToVector‘ » Polygon
+ Contour 1

Fig. 6. Geographic processing services providing a ready-to-use set of generic functions

These processing services produce results that may need to be archived for later discovery and access. This is the purpose of
the Archiving and Resources Management Services (ARMS) also published as specific OGC WPS profile which can store
data on different servers such as FTP, WFS, WCS in a consistent way with extracted result meta-information inserted in a
connected catalogue. Reporting services have been added to present data according to customizable report template and to
some selected file format (PDF, HTML, ...). Reporting services are available as web services that can be invoked either from
a dedicated reporting portlet user interface or from any other web service client.

2.4 ORCHESTRATION SERVICES

On top of these web services, a workflow engine allows to chain and or automate web services execution e.g.
processing chains, execution of simultaneous search requests in several remote catalogues. The orchestration is
facilitated by the ARMS that provide a durable persistence of several types of resources and also a uniform way
to address them using a URN. This should solve the classical input/output parameters mapping issues in the
processes chaining. To remove the complexity of designing service orchestrations (based on WS-BPEL
standard), an Orchestration Design GUI allows non-technical users to construct orchestration workflows in a
very simple manner by drag-and-drop of preconfigured “services” onto a workflow area. This GUI produces
output according to the BPEL4WS1.1 and OASIS WS-BPEL2.0 standards and deploys this output via to a WPS-
T interface to the either the PEtALS EasyBPEL engine either to the Oracle BPEL engine following the
GENESIS philosophy to propose several alternatives for the different components among COTS and Open
Source Software solutions.
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Fig. 7. Orchestration design tool allowing to simply chain services with any BPEL knowledge

2.5 GENESIS SERVICE PORTAL

A generic portal proposes user interfaces to interact with the previously defined web services (orchestration
services, discovery services, processing services ...). The portal is components (portlets) based allowing easy
integration of additional web user interface components compliant with JSR-286. It includes a number of
templates that allows to easily instantiate portal user interface to interact with remote web services based on
standards interfaces such as OGC CSW, WPS...

A portal factory toolkit simplifies the portal customization in terms of look and feel (themes), portlets
available on the different portal pages. The portal proposes standard portlet such as news, user management and
also new portlets such as decision support, system supervision. Thanks to its connection to a SKOS repository
with multilingual terms, the catalogue user interface on the portal shall allow users to define queries on
catalogues based on terms of their own language. One of these dedicated portlets, the Geodata Visualisation
provides a graphical user interface to interact via a map with the different data access services (WMS, WCS,
SOS...) offering the user not only to select features on the map such as an area of interest but also to display
processing results such as animated map, all kinds of data charts...
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Fig. 8. Portal Earth Observation Products Catalogue Client

A security layer based on relevant international standards (WS-Security, XACML SAML,...) including the
authentication and authorization services protects the access to the services based on rules configured in front of
each service provider site. These rules authorize the access to the service based on the identity of the service
invoker (generally user on the portal) and also based on the service input message information.

3 GENESIS PILOTS

To validate the pertinence of the GENESIS solution, our pilots deploy thematic applications based on our
components with the aim of fulfilling the requirement of their own users. As can be seen in the following
descriptions, this covers a quite large range of topics.

The pilot AQ-1 in Bavaria (Germany) aims at supporting the derivation and application of an Integrated
Health Index (IHI) for the combined impact of meteorological (temperature variations, humidity) and air quality
(ozone, nitrogen dioxide, particulate matter) parameters for elderly people affected by COPD (Chronic
Obstructive Pulmonary Disease). In the diagnosis mode medical information from regional ambulance databases
is used to train the IHI algorithm. GENESIS provides specific visualization tools for data screening and standard
pre-processing tools for the integration of the environment and health data with a spatial background data set, i.e.
postal code areas. As the statistical analysis needs to deal with large data amounts to assure statistical
significance from potentially different databases, the GENESIS solution offers a high benefit for this analysis
work. With the IHI algorithm designed, daily forecast maps of the IHI for all Bavaria and adjacent regions are
calculated as baseline for information services for citizens affected by COPD or medical staff. The IHI
calculation and visualization use web processing and web-GIS functionalities provided by the GENESIS
solution.

The pilot AQ-2 uses GIS technology to trace statistical trajectories of individual persons and population
groups throughout the day in the Greater London area. Here the underlying GMES information used are daily
forecast maps of high resolution (i.e. street level) air pollutant concentrations. Using GIS technology and further
datasets of person’s behaviour (indoor, outdoor, way to work, ....) the pollutant exposure for single persons is
calculated, fully exploiting the high resolution of the air pollution base data. This facilitates epidemiological
studies, for example to assess the impact of the London Low Emission Zone. GENESIS tools enable the GIS
analysis and the integration of different datasets into a standardized environment simplifying the transfer of the
approach tested to other regions.
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Fig. 9. The six GENESIS pilots covering 6 countries and 3 thematic topics (Air Quality, Water Quality and Health)

In the area around Nice, pilot AQ-3 investigates the derivation and application of a health risk index for air
pollution and pollen information regarding elderly people affected with asthma. This region has significant
episodes of pollen and high pollutant concentrations and is inhabited by large population and many tourists
during summer. The collaboration with hospitals and pharmaceutical networks provides medical information for
the development and validation of the approach. GENESIS supports the integration of the different data sets and
their joint processing. In addition, an interactive interface to collect patient feedback on their individual health
conditions related to the forecasted risk index is beeing designed and demonstrated using GENESIS tools.

The pilot WQ-1 — Oder/Odra estuary deals with the question of trans-boundary river basin management.. The
pilot aims to forecast, inform and alert the population in case of a biological or accidental pollution risk. It
addresses issues like accidental contamination, transport of pollutants and risks of virus infections in the estuary
as well as the water transparency during summer. The principal aim of the Oder/Odra estuary pilot is the
provision of an online information system for users interested in the hygienic water quality of the Oder/Odra
lagoon. The system also supports sanitary inspectors in deciding about a bathing ban on the beaches. The
interface between scientific insights and their implications for the water quality on the one hand and the users
and their concerns on the other hand will be provided by an interactive website to be developed in the last year of
the GENESIS project.

In second Water Quality Pilot (WQ-2), the site of Villerest artificial lake on the Loire river is used as a model
to study and test the relevance of the application of remote sensing techniques combined with in-situ monitoring
of cyanobacteria concentration in a large-sized aquatic ecosystem. This site was chosen because it shelters every
year a proliferation of the toxic cyanobacteria Microcystis Aeruginosa. These proliferations are difficult to be
monitored because of the strong heterogeneity of the spatial distribution of the cyanobacteria. This heterogeneity
requires multiple samplings to obtain a good estimation of the intensity of the proliferation on the scale of the
reservoir, especially to anticipate the problems arising in particular locations of the lake such as the bathing,
recreational and fishing zones.

The last pilot focuses on Lake Constance is a transboundary lake shared between Germany, Switzerland and
Austria and the important drinking water reservoir. More than 4 Mio inhabitants are supplied by the clean lake
water without considerable treatment. In recent years a comprehensive information system called
BodenseeOnline was developed in a cooperative research project. To enhance the ability of BodenseeOnline to
serve as a decision support system, the GENESIS Project framework is used. The pilot has a special part of the



project as it only started during the last year of the project to check that it was possible to address a new
application with GENESIS generic components. They are using the same software package and receive support
as if they were real external users, allowing to validate the soundness of the GENESIS approach.
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Fig. 10. AQ1 Pilot example — Average NO2 density time series for selected Bavarian sites.

4 GENESIS ACTORS

In order to efficiently set up such system, different roles have been identified. Technology developers implement
the various generic components based on the most appropriate and up to date technology. These generic
components are then instantiated by service providers to implement the needed services with the support of
thematic experts. These different services are then progressively connected together by the system integrators.

Once the system has been integrated, it can be validated by the experts and then finally offer to the end users
which can be the man in the street as well decision makers.

Note that this full lifecycle is implemented inside the FP7 GENESIS project. A dedicated team is in charge of
the system integration and maintenance of a reference platform where all most GENESIS components are
installed. This system on this reference platform is validated with end-to-end scenarios representative of thematic
usage. Within the GENESIS project itself, the system performance and robustness is further experimented
through six different thematic pilots, covering various aspects of Air Quality and Water Quality monitoring, such
as integrated health index computation in Bavaria (Germany), daily pollutant exposure for individual persons in
London, trans-boundary river basin management Oder Odra estuary (Poland)...
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5 CONCLUSION

GENESIS solution proposes a number of components including a Portal and Web Services based on up to date
standards, technologies and European directives such as INSPIRE. Users have the choice of selecting isolated
components or to rely on the integrated system to build their environmental application. The project is in its final
stage working in parallel on the exploitation plan and the last validation phase by different pilot applications in
the Air Quality and Water Quality domain.
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